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ABOUT THE AUTHOR

I am a photographer, traveller and writer with a fascination for Africa, her wildlife and wild 
places. My aim in photography, travel and writing, is to depict Africa with a 
conservationists’ slant.

For as a childhood hero, Jacques Cousteau said; “People protect what they love”.

I want the world to fall in love with African nature, to treasure it, just as I have done, before 
it slips away.

Some of my photography can be found in my limited edition prints and much more of it on 
my blog, Youtube , Facebook Page and Instagram.

Alternatively, if you are interested in African travel, nature or photography in general, 
please drop me a line – I’d love hear from you!

www.willgoodlet.com
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HOW LIGHTROOM STORES 
IMAGES

1

The quick answer is that Lightroom (LR) never stores images.

Never, ever delete your original files thinking that LR holds a copy. It does NOT.

Instead, LR holds information about where our image file is located on our hard disk and a 
preview of the image file.

LR does this by holding information in a database, known as the LR Catalogue, and in a 
separate previews cache file.

Both the Catalogue and Previews Cache are created when you install LR. They work as a 
team to show us the image in the Lightroom application.

These two files should always be kept in the same folder. If the Previews Cache goes 
missing, LR will create a new one using your original images as the source of the new 
previews.

It is possible to have more than one LR Catalogue and this can sometimes be useful when 
we run out of storage space - but that is food for another eGuide!
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Here’s a diagram to explain:
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SYSTEM REQUIREMENTS
2

LR is a hungry beast. It craves system resources.

Adobe currently recommends exceeding system requirements with these as a starting 
point: 

CPU
64-bit Multi-core processor (for best performance up to 6 cores - especially if you use 
multiple hi-res monitors). Please note that more than 6 cores could potentially slow LR 
down

RAM
12 GB of RAM - more if you use Photoshop (PS) at the same time.

FAST HARD DRIVES
Use fast Solid State or NVME drives especially for the Catalogue and Previews. We do not 
need especially fast drives for the actual image storage because LR rarely accesses these 
files
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SYSTEM CONFIGURATION
3

I know a lot of people use LR on a notebook which has limited options for special 
configuration but it is worth talking about system configuration for desktops because it 
can make a massive difference to performance.

BAD HABITS TO AVOID
If we use multiple computers it can be tempting, maybe imperative, to have all of the 
catalogues, previews and actual images on one external hard drive. It is super convenient, 
just plug and play into any computer with the LR application on it, especially when 
travelling.

However, this is a common performance bottleneck.

If we do this, we must have fast connections between the external drive and computer. 
Luckily, this is more common these days.

Here’s a list of connection speeds:

• Thunderbolt (Mac) 10GB/sec
• eSata 600MB/sec
• PCIe 500MB/sec
• USB3 400MB/sec
• USB2 35MB/sec - Not fast enough!! 

So, if LR is slow and you use an external drive the very first thing to check should be 
the speed of the connection!
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OPTIMAL INSTALLATION
Due to the fact that LR separates the Application, from the Catalogue & Previews and the 
Actual Images, there is a good opportunity to both save money and improve performance.

We can install the application on a fast drive, independent of the Catalog/Previews and 
Images.

We can Install the Catalog/Previews on another fast drive (easy to backup separately).

We can save the Actual Images to a slow mechanical drive without incurring much of a 
penalty at all. This allows us a huge saving, because mechanical storage for large image 
files is very cheap compared to fast SSD storage. It also allows easy backup of the just 
the images.
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RAW PREVIEW CACHE
I haven’t mentioned the RAW Preview Cache before now but it is important to know about 
this when configuring the system.

The RAW Preview Cache is yet another cache and not the same as the LR Preview Cache. 
It holds the high detail previews that we work on when using the LR Develop Module.

These large files take up a lot of space but offer a lot of flexibility. The location of this 
cache is defined in LR Preferences.

We should store this cache on a fast SSD or nVME drive. I prefer to create a separate 
partition for this cache with no other files on there.

A partition is a logical storage area on a hard drive that looks and behaves like a separate 
hard drive. So any hard drive can be split up into different sized partition/volumes and the 
computer will think that these are all different hard drives.

Create a partition in Windows 10

Create a partition on a Mac

I have one SSD disk purely for Photo-editing applications & Caches:
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SYSTEM OPTIMISATION
4

1.	Hard Drive Space - ensure that the OS drive and the drives holding the LR 
application, LR Catalogue, LR Preview Cache & RAW Preview Cache have more 
than 20% free space.

2.	Disk Cleanup - if you run out of space use Disk Cleanup (Windows) to make more 
space and delete unnecessary files. One reason I like installing LR on separate 
disks is so that unnecessary files and downloads don’t clog up those disks only the 
OS disk.

3.	Defragment - If you are running mechanical drives defragment them for optimal 
performance. NB// Do not defragment SSD’s as this will reduce lifespan.

4.	Updates & Patches - ensure the latest software patches, driver updates and OS 
updates are installed, especially for the Graphics Processing Unit (Display).

5.	TSR’s & Background Apps - close unnecessary applications and pause 
background apps like antivirus, cloud backup etc...

6.	Hi-Res Displays - if you are working on a Hi-Res display and LR is running slowly 
then consider reducing the size of the application window. Making the application 
window smaller will reduce the strain placed on the system to render graphics. 
Hi-Res displays have resolution of 2560 x 1600 or greater. We can also use 1:2 or 
1:3 views in the LR Navigator panel to improve performance (i.e. Not the ‘Fit’ or ‘Fill’ 
options) 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7.	Resolution - directly impacts performance. Reducing your displays resolution to a 
lower value can sometimes improve performance.
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LIGHTROOM  CACHE
5

We’ve already discovered that LR has two different Caches.

One, the LR Preview Cache, holds previews for the various adjustments and thumbnails 
shown in the Grid View.

The second, the RAW Preview Cache, holds high quality images showing the latest 
adjustments in the Develop Module.

RAW PREVIEW CACHE SIZE & LOCATION
LR Preferences allows us to specify both the size and location of the RAW Preview Cache.

By default LR sets the size of the cache to 1GB. This is woefully inadequate. We should 
correct this in preferences.

Set the size of the Cache to a minimum of 20GB. Preferably, set the location to a separate 
special volume provided (as discussed in Chapter 3). There is no penalty, if we have the 
space, in making this as large as possible.

This cache should be located on a fast drive.
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STEP 1

STEP 2 - Select ‘Preferences’
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STEP 3
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CATALOGUE OPTIMISATION
6

The LR Catalogue file is used constantly. It is written to pretty much any time we do 
something in LR.

So, best practice is to keep it optimised. The easiest way to do this is to enable the right 
options when exiting LR.

Choose the option to ‘Test Integrity Before Backing Up’ and ‘Optimise the Catalogue After 
Backing Up’ when you close down the LR application.

If we haven’t optimised or backed up in a while then we can choose to optimise it 
manually by selecting ‘File>Optimize Catalog’
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PREVIEWS
7

PREVIEW TYPES
We can choose from a number of types of preview when importing images to LR.

MINIMAL - Not used in Develop Module
Small JPEG previews embedded in your camera photos. These are the fastest ones to use 
when importing to LR.

EMBEDDED - Not used in Develop Module
These are larger previews, also created by our camera, taking a little longer to import.

STANDARD - Not used in Develop Module
These are created by LR during import and so take longer. They are generated by LR and 
NOT the camera, so they can actually look different from the smaller previews.

We can specify the size of Standard Previews based on the size of our display. 

Try to keep Standard Previews as small as possible to improve performance. This will also 
save HDD space.

Choose to size these by selecting the size that most closely matches the longest edge of 
the monitor. So, for example, if we have a screen resolution of 1920 pixels x 1200 pixels 
we should choose a Standard Preview Size of 2048 pixels and a quality of Low or 
Medium.
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To set the size, choose:

• (Windows) Edit>Catalog Settings>File Handling

• (Mac) Lightroom>Catalog Settings>File Handling 

1:1 PREVIEWS
This is a 100% pixel level view of the image. It is used in the Develop Module. When 
generating these on import, LR also generates Minimal & Standard as well - so it can take 
a LONG time to import 1:1 previews.

Whenever we zoom in to 100% or higher LR will use or create a 1:1 Preview there and 
then (or use a saved one if cached). This can obviously take a bit of time and adds to the 
slow, glitchy feel of the interface.

When we work on files, LR needs different previews for different tasks. It has to generate 
them when it needs them. By choosing to import 1:1 previews instead, we can save a lot 
of time because LR has all the previews it will ever need saved into the RAW Preview 
Cache.

The only two downsides to this are 1, it is time-consuming to import 1:1 previews. 2. It will 
take up a large amount of hard drive space.

Rendering 1:1 Previews on import and keeping them indefinitely (or until no longer 
needed) will produce the fastest and best LR experience.
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BUILD 1:1 PREVIEWS ON IMPORT

BUILD 1:1 PREVIEWS LATER ON IN LIBRARY





XMP METADATA
8

LR stores a lot of metadata directly inside DNG files or for other files, in ‘sidecar’ (XML) 
files held alongside the original images.

This is not for LR to use but to maintain compatibility with other software, for example 
Adobe Bridge and Camera RAW.

Writing back to these files every time there is a change in a star rating, colour label or 
keyword can take a lot of time. Particularly, if we have also stored those images on a slow 
mechanical drive (which is very likely).

We can turn off this behaviour to improve LR Performance.

It is most useful to turn the feature off if we stay mainly inside LR. If we move around a lot 
between applications it is probably better to keep it turned on, so we don’t forget to save 
the data.

However, turning off XMP can really help to improve performance.

To turn off XMP Saving:

• (Windows) Edit>Catalog Settings>Metadata Tab - Deselect ‘Automatically Write 
Changes into XMP’

• (Mac) Lightroom>Catalog Settings>Metadata Tab - Deselect ‘Automatically Write 
Changes into XMP’
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GPU PROCESSING
9

LR surprisingly, does not make too much use of the Graphics Card (GPU) on our systems.

However, it can make use of it for some operations and especially on large or multiple 
displays.

So the best option is to turn GPU Processing ‘ON’.

Sometimes, GPU Processing causes instability in LR and in these situations it is much 
better to turn GPU Processing ‘OFF’

In either case, the cost or benefit in performance is minimal. Just choose what is best for 
your system stability.

To turn On/Off GPU Processing:

• (Windows) Edit>Preferences>Performance - check/uncheck ‘Use Graphics 
Processor’

• (Mac) Lightroom>Preferences>Performance - check/uncheck ‘Use Graphics 
Processor’ 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SYNCHRONISATION
10

By default, changes in LR Classic will sync with Lightroom CC / Mobile. This uses the CPU 
and RAM to create previews and then upload/download images from the cloud.

If we pause this operation temporarily it can improve LR performance.

It would be better to sync after we complete work in LR Classic.

The same is true for other options under the same menu: Face ID and Locations.
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ORDER OF ADJUSTMENTS
11

Adobe says the best order to complete adjustments in LR is as follows:

• Spot Healing

• Lens corrections

• Global non-detail - Exposure, White Balance etc...

• Local Corrections - Gradients, adjustment brush strokes

• Detail Corrections - Noise reduction & sharpening.

Avoid using lots of local adjustments and then, later global corrections as this makes 
changes to ALL of the local adjustments performed before.

If you have to perform a LOT of local adjustments, for example, spot removal on a film 
negative then it is better to do this to the image in a pixel editor like Photoshop first and 
then bring the edited image into LR. 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OTHER OPTIMISATIONS
12

ZOOM OPTIONS
As mentioned above, ‘Fit’ and ‘Fill’ 
zoom options can be very slow because 
the system has to calculate the correct 
size to display. Try to use standard sizes 
1:2, 1:3 and 1:4 instead.

PRESETS
In LR, the Develop Module creates 
thumbnails for all the different Presets 
installed. These are shown in the 
Navigator Panel for every single preset.

This can take time! For best performance use a minimal number of Presets in LR.

FOLDER SIZE
LR has to render and display thumbnails in the Library module. If the folder we are looking 
at is very large it has to create a LOT of thumbnails. If we have chosen to display all 
lower-level folders as well (a tick option in the Library Menu), this can also mean that LR 
needs to create a lot of thumbnails.

For best performance, break folders into <2000 or so images and turn off sub-folder 
visibility.
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UNCHECK ‘Show Photos in Subfolders’





LIGHTROOM AFFINITY (Windows)
13

We talked a little in Chapter 2 about the recommendation by Adobe to use 6 or fewer CPU 
cores for Lightroom.

So, how do we do that if our system has more cores than that?!

The answer is to instruct Windows to only allow LR to use a specified number of CPU 
Cores at startup.

We can do this at any time using the Windows Task Manager but it is more efficient to 
create a desktop batch file that carries this out for us and then starts LR.

To achieve this, all we need to do is to open Notepad (or any text editor) and paste in the 
following code to run with 4 Cores only (provided LR is installed on the C:\ Drive):

Then save the file to the desktop, but change the file extension to ‘ .bat’ instead of the 
default ‘ .txt’

Now, with LR closed, we can double click the batch file icon (the file we saved to the 
desktop) and it will run the script and start LR with only the selected number of CPU cores 
working.
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C:\Windows\SysWOW64\cmd.exe /c start  "lightroom" /affinity F  "C:\Program 
Files\Adobe\Adobe Lightroom Classic CC\Lightroom.exe"



ROLLBACKS
14

Finally, we have one more performance option up our sleeves if none of the above works.

We can rollback LR to a previous version when, perhaps, it was running much better.

This is easy to do using the Creative Cloud application:
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